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Chapter 1

Surface Design Overview

This chapter serves as an overview of wireframe and surface design fundamentals and 
the typical surface design process.

This chapter introduces:

Surfacing Tools in CATIA V5

Generative Shape Design Workbench

Surface Design Review

Design Intent

Tree Organization
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1.1 Surfacing Tools in CATIA V5

Surface features introduce additional flexibility to a model. Surfaces 
can be used to define a complete part or to integrate a complex shape 
into the solid part (in the Part Design workbench). As learned 
previously, many parts can be designed directly using solid geometry. 
However, when shapes become more complex, surface shapes must 
often be used. 

CATIA has several workbenches available to create surface 
geometry. The primary workbench is Generative Shape Design 
(GSD).

The GSD workbench contains the required tools for wireframe and 
surface design. Other surfacing workbenches available in CATIA are 
shown in Figure 1–1.

Figure 1–1

The Wireframe and Surface Design workbench has basic wireframe 
and surfacing capabilities.

The Freestyle workbench provides design tools for an Industrial 
Designer. Non-parametric wireframe and surface geometry can be 
quickly developed and optimized around conceptual drawings and 
models. 

The Imagine & Shape workbench contains non-parametric surface 
creation tools. The surfaces are NURBS based, enabling pushing and 
pulling on a mesh. Organic and freeform type shapes can easily be 
created. 
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1.2 Generative Shape Design 

Workbench

Access the GSD

Workbench

Until now, you normally worked in the Mechanical Design area of 
CATIA to develop part and surface models. Solid geometry was 
created in the Part Design workbench. To access the advanced 
surfacing functionality in CATIA, you must use the GSD workbench. 
To access this workbench, select Start > Shape > Generative Shape 

Design. The workbench symbol changes to .

GSD User

Interface

The interface for the GSD workbench is similar to the Part Design 
workbench. The primary difference is that the toolbar options change 
to GSD-specific tools, as shown in Figure 1–2.

Figure 1–2

Surfaced part

Workbench symbol

Sketcher access

Workbench tools

General tools

Specification tree

Prompt
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1.3 Surface Design Review

Designing surface features differs slightly from designing solid 
features in CATIA. With solid modeling, you can often visualize the 
final shape of a feature and create the geometry with individual 
construction features (e.g., Pad, Pocket, Fillet, or Hole). With 
surfaces, you must frequently create reference geometry (e.g., points 
and curves) before creating a single surface feature. Planning ahead 
is essential to achieving the desired results when designing surfaces. 

When creating solid features, all faces of the feature must be defined 
in one step. The intersections of solid features are immediately 
calculated and consumed in the model. With surfaces, the contours of 
the model can be individually created as separate features. These 
multiple surfaces can then be joined to generate a final solid feature. 
As a result, simple surfaces have the benefit of being able to yield 
complex results. 

General Steps Use the following general steps to create a model from surface 
features:

1. Create wireframe geometry.

2. Create surface geometry.

3. Perform surface operations.

4. Create solid geometry.

Wireframe geometry is the backbone on which the surface features of 
the model are created. You can use wireframe features to define 
construction elements, intersections, and common boundaries of the 
surfaces that define the shape of the model. Wireframe geometry can 
consist of simple features, such as sketches, points, lines, and 
planes, as well as more complex geometry, such as splines or helixes.

Step 1 - Create wireframe geometry.
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Figure 1–3 shows an example of a group of wireframe features that 
are used to develop a surface model. 

Figure 1–3

Once the wireframe geometry has been created, surface features can 
be created to define the internal and external boundaries of the 
model. Surface features can be created independent from the rest of 
the model or by using existing wireframe and surface geometry as a 
reference. Common surface types include:

� Extruded

� Revolved

� Spherical

� Offset

Step 2 - Create surface geometry.
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The boundaries of the model shown in Figure 1–4 are completely 
defined. Although the surfaces appear to form a closed shape, they 
still need to be joined before making the solid model.

Figure 1–4

The advantage of using surface features is being able to control how 
individual surface features connect and interact with other parts of the 
model. Surface operations are used to control this interaction by 
enabling you to manipulate existing surface features. Common ways 
to manipulate surfaces include: 

� Join 

� Split 

� Trim 

� Extract 

� Transform

Step 3 - Perform surface operations.
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The model shown in Figure 1–5 uses the Join option to define the 
resulting surface shape.

Figure 1–5

When you finish creating surface features, you are ready to create 
solid geometry. At this point, your model contains a surface 
representation of the 3D model. This can be a closed surface or an 
open surface depending on your design intent. 

If the mass properties of your model are required or you intend on 
performing additional solid modeling, you must create solid geometry 
from the surfaces. You must take the model back to the Part Design 
workbench and use the Surface-Based Features toolbar options to 
create solid geometry from the skin. These options include Close 
Surface, Thick Surface, Split, and Sew. 

Step 4 - Create solid geometry.

Joined surface shape

Hidden wireframe and surface 

features used to construct join
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The solid geometry is added to the PartBody, as shown in Figure 1–6.

Figure 1–6
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1.4 Design Intent

The key to building parametric, feature-based, surface models is to 
construct them so that their behavior is flexible and predictable. This 
process is known as capturing design intent.

You should already be familiar with several methods of capturing the 
design intent with a solid part model. These methods are applicable to 
the creation of surface features, which include the following:

When designing surfaces. 
decisions should always 
be made to drive the 
design intent of the 
finished model.

� Dimension sections and features so that your model updates 
based on your design intent. 

� Select Depth options for your features to drive your design intent.

� When applicable, use symmetry conditions to drive the design 
intent.

Surface

Modeling

Methods

Surface features introduce additional flexibility into the model because 
of the different ways in which a surface model can be created. 
Modeling methods include the following:

� Boundary

� Slab

� Hybrid

Boundary

The geometry of a model can be defined by a series of curves, known 
as a curve network. The curve network is the backbone on which 
many surfaces are created. It can be used to define the intersections 
or common boundaries of surfaces that define the shape of the model. 
A curve network is used to create the model shown in Figure 1–7.

Figure 1–7
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The advantages of boundary modeling are:

� Enables precise control over shape and continuity.

� More complex shapes can be created from the curve network.

The disadvantages of boundary modeling are:

� Longer setup time for required reference geometry.

� Can be time consuming to update necessary design changes.

Slab

Models can be defined by creating simple surfaces. Once these 
surfaces have been created, they can be trimmed, split, or joined to 
create the desired shape. This method of construction is frequently 
used when the surface geometry can easily be broken into simple 
geometric shapes. These surfaces are typically called Slab or Blocked 
surfaces. Simple slab surfaces are shown in Figure 1–8. A more 
complex example is shown in Figure 1–9.

Figure 1–8

Figure 1–9
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The advantages of slab modeling are:

� Simple surfaces take less time to create than a network of curves.

� Slab surfacing is easier to make design changes to downstream, 
than curve networks.

The disadvantages of slab modeling are:

� The order in which the surface operations is performed can create 
undesired results.

� Cannot always capture the design intent with simple surfacing 
techniques. 

Hybrid

Models can be defined by combining the boundary and slab surface 
methods. This is the most common method of creating surface 
models in CATIA. Slab surfaces are generally used to start the model 
and curve networks are generated, as needed, to complete the 
geometry. Three simple, extruded, slab surfaces and a curve network 
are shown in Figure 1–10. This example shows the two techniques 
used to generate the required geometry.

Figure 1–10
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Boundary

Representations

A boundary representation refers to the selection of any sub-element 
when defining references for a feature. This means that a feature in 
the specification tree is not directly referenced. Instead an entity 
belonging to a feature, such as the edge or vertex of a surface, is 
selected. Whenever a boundary representation is selected, CATIA 
reports the reference using <feature>\<sub-element>. For example, 
Sweep.1\Edge is shown in Figure 1–11.

Figure 1–11

Selecting a boundary representation makes the model less stable. 
Modifications to features can cause the deletion of a sub-element, 
resulting in errors. The best practice is to reference non-boundary 
representations, also known as explicit elements. These display 
directly in the specification tree. Referencing explicit elements 
promotes a more stable model that you have more control over.

Recommended practices

� Create Extract and Boundary curves instead of directly referencing 
an edge.

� Use Sketch Profiles and Sketch Outputs when a sketch element 
needs to be referenced.

� Create points manually instead of selecting a vertex.

� Use the Replace tool when design modifications are needed.

On curve point created referencing 

a Boundary Representation
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� Use contextual menus to easily create proper reference geometry 
as shown in Figure 1–12.

Figure 1–12
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1.5 Tree Organization

The specification tree can become very long and messy in large 
models. You should already be familiar with some techniques to 
organize the tree, including inserting and changing geometrical sets to 
help separate and order like elements. Renaming features and 
geometrical sets also makes updating and investigating a model 
easier. The Autosort command is also helpful in managing the 
feature order in a geometrical set. Other tools exist to help organize 
the specification tree. 

Groups Groups enable you to control the display of features within the 
specification tree and can be used as a filter. Groups are created from 
an existing geometrical set. Features from that geometrical set are 
added to the group. When the Group is collapsed, only features 
added to the group are shown in the specification tree. When the 
Group is expanded, all features from the geometrical set are 
displayed as shown in Figure 1–13.

Figure 1–13

Use the following steps to create a group:

1. Right-click on a geometrical set from which to create the group.

2. Select &/ object > Create Group in the contextual menu.

3. Enter a name for the group. 

4. Select features from the geometrical set to place in the group. Any 
added feature is shown in the group when collapsed in the tree. All 
other features of the geometrical set are not shown in the 
specification tree.

Group created to 

only display spline

Expanded group 

displays all features 

Collapsed Group Expanded Group



CATIA: Advanced Surface Design

1–16 © 2011, ASCENT - Center for Technical Knowledge®

5. Click  to complete the creation of the group.

To collapse or expand a group, right-click the group in the 
specification tree and select &/ object > Expand Group or &/ object 
> Collapse Group.

Grouping is a very useful option. With Groups, insignificant 
construction or reference elements can be hidden in the specification 
tree. This makes the specification tree very concise and easy to 
review, which improves the effectiveness of the editing process.

If a group was the active geometrical set, any new feature added to 
the model would not be displayed in the specification tree until the 
group was expanded. For example, a point is added to the model, but 
not as an input to Group-Geometrical Set.1. The point is not displayed 
unless the group node is expanded.

There is an option that enables you to automatically add new features 
as input to the active group. To activate this option, select Tools > 
Options > Shape > Generative Shape Design, select the General 
tab, and enable the Integration of created feature as group inputs 
option, as shown in Figure 1–14.

Figure 1–14

All new features are now added to the active group. Features can be 
removed from the group by right-clicking on the group node and 
selecting Edit Group. This only applies to features created in the 
Generative Shape Design workbench.

AutoSort AutoSort is a command that organizes the features in a geometrical 
set. When AutoSort is performed on a geometrical set, the features 
are reordered by the order in which CATIA updates the features. 
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Use the following steps to use the AutoSort command:

1. Select a geometrical set, as shown in Figure 1–15.

Figure 1–15

2. Right-click and select &/ object > Autosort as shown in 
Figure 1–16.

Figure 1–16

3. The result displays as shown in Figure 1–17. Spline.1 was moved 
below Point.5. This is because Point.5 was used to create 
Spline.1.

Figure 1–17

Select a 

geometrical set.
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Mask The ability to create a mask was added to the R16 version of the 
Generative Shape Design workbench. A mask is used to simplify the 
display of a part model.

 (Mask) has been added to the Tools toolbar, as shown in 
Figure 1–18.

Figure 1–18

Alternatively, select Tools > Mask in the menu bar, as shown in 
Figure 1–19.

Figure 1–19
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CATIA displays a bounding box around the part when a mask is 
created, as shown in Figure 1–20. The box has six sides, each of 
which has a green dot. The dot represents a handle that can be 
moved by selecting and dragging it with the cursor.

Figure 1–20

The part updates to exclude any surface or reference geometry that is 
completely outside of the bounding box, as shown in Figure 1–21.

Figure 1–21
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You can place the bounding box using the Coordinates or Position & 
Dimensions option in the Mask Type pull-down menu, as shown in 
Figure 1–22. With the Coordinates option, you place the box relative 
to selected points or vertices from the model.

Figure 1–22

You can create multiple masks for a single part. CATIA lists all masks 
under the Masks node of the specification tree, as shown in 
Figure 1–23. 

Figure 1–23

Only one mask can be active at a time. The symbol of an active mask 
displays in red. The active mask is circled in Figure 1–24.

The symbol of an active 
mask displays in red and is 
visible within CATIA.

Figure 1–24
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Exercise 1a Hybrid Surface Modeling

In this exercise, you will investigate tangency conditions of curves and 
surfaces. The Boundary method of surfacing will be used. The slab 
method of modeling produced the surfaces provided for you to start 
with. You will work through a typical surface-based modeling process, 
from wireframe to the creation of solid geometry from a surface. 

The completed model is shown in Figure 1–25.

Figure 1–25

Goal After you complete this exercise, you will be able to:

Investigate curve tangency conditions

Create a curve with tangency

Create a surface from curves

Define tangency conditions for a surface

Organize surface data

Create a solid from surfaces
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Task 1 - Open a part file.

1. Open Y_Pipe.CATPart. The model displays as shown in 
Figure 1–26.

Figure 1–26

2. In the specification tree, note that the geometry has been 
organized into geometrical sets. Also note that NewSurfaces is 
the work object as shown in Figure 1–27.

Figure 1–27
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Task 2 - Change the display of bodies.

1. Hide the OriginalSurfaces geometrical set.

2. Show the Curves geometrical set. The specification tree will 
display as shown in Figure 1–28.

Figure 1–28

The model displays as shown in Figure 1–29. 

Design

Considerations

The visible geometry can be referred to as a curve network. Creating 
a curve network provides a wireframe structure that permits the 
creation of surface features.

Figure 1–29
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3. Show OriginalSurfaces as shown in Figure 1–30.

Figure 1–30

4. Show NewSurfaces as shown in Figure 1–31.

Figure 1–31

Design

Considerations

Currently, the NewSurfaces geometrical set contains four fill 
surfaces. Later in the exercise, you will develop additional surfaces to 
create a complete skin for the Y-Pipe.

5. Hide NewSurfaces.
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6. Hide OriginalSurfaces as shown in Figure 1–32.

Figure 1–32

7. Hide the appropriate curves so that only the seven shown in 
Figure 1–33 are visible.

Figure 1–33
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Task 3 - Investigate tangency options for a curve.

1. Select the yz plane in the specification tree and show it.

2. Edit the curve shown in Figure 1–34.

Figure 1–34

3. The curve is a spline curve with a tangency condition applied to 
both ends. This is shown in the Tangents Dir column, as shown in 
Figure 1–35.

Figure 1–35

4. Click  to view the tangency references.

Double-click on this curve
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5. Select Extremum.6 in the Points column in the Spline definition 
dialog box, as shown in Figure 1–36.

Design

Considerations

For this end of the curve, a plane is used to defined tangency. If a 
plane is used as a Tangents Dir reference, the curve is normal to the 
selected plane at that end.

Figure 1–36

6. Select Extremum.10 in the Points column.

7. Right-click on Plane.3 in the Tangents Dir field and select 
Hide/Show, as shown in Figure 1–37.

Figure 1–37

Right-click in 

Tangent Dir field
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8. Click .

9. Ensure that the two reference planes are visible in the model, as 
shown in Figure 1–38.

Figure 1–38

Task 4 - Create a spline curve with tangency.

1. Show the following from the Points geometrical set, as shown in 
Figure 1–39:

� Extremum.1

� Extremum.8

Figure 1–39

2. Show the NewSurfaces geometrical set.

These two reference planes should be visible.
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3. Ensure that Curves is the active work object. The specification 
tree and model display as shown in Figure 1–40.

Figure 1–40

4. Click  (Spline) and select the two Extremum points that have 
been shown.

5. Select the appropriate reference planes to define tangency for 
each of the two points, as shown in Figure 1–41.

Figure 1–41

6. Click .

Define in work object
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Task 5 - Create a surface from curves.

1. Define NewSurfaces to be the work object, as shown in 
Figure 1–42.

Figure 1–42

2. Click  (Fill) and select the four boundary curves shown in 
Figure 1–43.

Figure 1–43

3. Show OriginalSurfaces.

Define in work object
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4. Define the support for the three fill boundaries, as shown in 
Figure 1–44.

Figure 1–44

5. Complete the fill surface. The model displays as shown in 
Figure 1–45.

Figure 1–45
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6. Create another fill surface using the five boundaries shown in 
Figure 1–46. Ensure that the adjacent surfaces are selected as 
support references. Define Tangent as the continuity type.

Figure 1–46

7. Complete the fill surface.

Task 6 - Create a single surface feature.

Design

Considerations

Since your goal is to create solid geometry from a surface model, all 
surfaces (extrude and fill) need to behave as a single element for a 
thick surface feature creation to be successful. To help keep the 
geometry organized, you will insert a new geometrical set to hold the 
Join feature that will be created in this task.

1. Select Insert > Geometrical Set and enter the following as shown 
in Figure 1–47:

� Name: JoinedSurfaces

Figure 1–47
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2. Click .

Design

Considerations

The new geometrical set is positioned directly beneath the previously 
activated geometrical set.

3. Click  (Join).

4. Select any of the surfaces of the model.

5. Right-click in the Elements to Join field and select Distance 
Propagation, as shown in Figure 1–48.

Figure 1–48
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Design

Considerations

This propagation tool enables the system to automatically select all 
surfaces that have boundaries that are within the Merging distance 
parameter value.

All nine surfaces should be listed in the Join dialog box, as shown in 
Figure 1–49. (Listing order might be different in your model.)

Figure 1–49

6. Click . The join is added to the JoinedSurfaces body as 
shown in Figure 1–50.

Figure 1–50
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7. Hide all geometrical sets except for JoinedSurfaces as shown in 
Figure 1–51.

Figure 1–51

Task 7 - Create solid geometry.

1. Activate the Part Design workbench.

2. Define the PartBody to be the work object.

3. Use  (Thick Surface) to create a 2mm thick solid from Join.1 
in the direction shown in Figure 1–52.

Figure 1–52
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4. Select Tools > Hide > All Geometrical Sets to hide all wireframe 
and surface geometry that is still shown. The completed model 
displays as shown in Figure 1–53.

Figure 1–53

5. Save the file and close the window.
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Exercise 1b Front Quarter Panel

In this exercise, you will create the front quarter panel of an 
automobile as shown in Figure 1–54. 

Figure 1–54

Goal After you complete this exercise, you will be able to:

Use Slab surface modeling techniques

Perform surface operations

Create surface fillets

Project curves

Organize wireframe and surface data

Task 1 - Open a part file.

1. Open Front_Panel_Start.CATPart. The model displays as shown 
in Figure 1–55.

Figure 1–55
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2. Ensure that the model units are set to [mm].

3. Hide the following elements:

� Base

� 1/4 Panel - Door Profile

� Front Project Sketch

Task 2 - Create wheel surfaces.

 (Extrude) is located in 
the Surface toolbar.

1. Create an extruded surface using the following specifications:

� Profile: Wheel Well Sketch

� Direction: ZX plane

� Limit 1: 1010mm

� Ensure that the direction of the extrude is created towards the 
existing surfaces.

2. Rename the completed extrude as [Wheel Extrude]. The model 
displays as shown in Figure 1–56.

Figure 1–56

3. Hide Wheel Well Sketch.

 (Offset) displays in 
the Surfaces toolbar.

4. Create an offset surface using the following specifications:

� Surface: Swept Surface.1

� Offset: 45mm

The Offset direction displays as shown in Figure 1–57.

Figure 1–57

Direction arrow
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5. Rename the completed offset surface as [Body Offset]. The model 
displays as shown in Figure 1–58.

Figure 1–58

6. Create another offset surface using the following specifications:

� Surface: Wheel Extrude

� Offset: 25mm

The offset direction needs to point outside of the Wheel Extrude 
surface.

7. Rename the completed offset surface as [Wheel Offset]. The 
model displays as shown in Figure 1–59.

Figure 1–59

Task 3 - Split surfaces.

Click  to 
toggle which portion of the 
surface is kept in the Split 
operation. 

1. Hide Body Offset.

Body Offset

Wheel Extrude Wheel Offset
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2. Click  (Split). Select Wheel Offset as the element to cut. The 
cutting elements are Body Offset, Swept Surface.1, and Base. 
The completed split displays as shown in Figure 1–60. 

Figure 1–60

3. Rename the split as [Wheel Outside Split].

4. Split Wheel Extrude. The cutting elements will be Body Offset, 
Swept Surface.1, and Base. The completed split displays as 
shown in Figure 1–61.

5. Rename the split as [Wheel Inside Split]. 

Figure 1–61

Split surface

Wheel Inside Split
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6. Show Body Offset and Base.

7. Split Body Offset. The cutting elements will be Wheel Outside 
Split, Wheel Inside Split, and Base. The completed split displays 
as shown in Figure 1–62.

8. Rename the split as [Wheel Front Split].

Figure 1–62

9. If not already done, hide Body Offset, Base, and Wheel Inside 
Split.

10.Split Swept Surface.1. The cutting element is Wheel Outside 
Split. The completed split displays as shown in Figure 1–63.

11. Rename the split as [Body Split].

Figure 1–63

Wheel Front Split

Body Split
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Task 4 - Use Project curves to split.

 (Join) displays in the 
Operations toolbar.

1. Join Swept Surface.2, Wheel Outside Split, Wheel Front Split, 
and Body Split.

2. Rename the Join as [Surface Join].

3. Show 1/4 Panel - Door Profile and Front Project Sketch.

 (Projection) displays 
in the Wireframe toolbar.

4. Create a projected curve using the following specifications:

� Projection type: Along a direction

� Projected: 1/4 Panel - Door Profile

� Support: Surface Join

� Direction: Y-Component or the ZX-plane

5. Rename the completed project as [Projected Door Curve]. The 
model displays as shown in Figure 1–64.

Figure 1–64

6. Repeat Step 4 using Front Project Sketch. Rename the projected 
curve as [Projected Front Curve]. The model displays as shown in 
Figure 1–65.

Figure 1–65

7. Hide 1/4 Panel - Door Profile and Front Project Sketch.

Projected Door Curve

Projected Front Curve
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8. Split Surface Join using Projected Door Curve and Projected 
Front Curve as the cutting elements. The completed split displays 
as shown in Figure 1–66.

Figure 1–66

If a color does not display 
in the list, select More 

Colors.

9. Using the graphic properties, color the surfaces gray.

10.Save the model.

11. Using the Edge Fillet tool place fillets on the edges of the wheel 
well as shown in Figure 1–67.

Figure 1–67

35mm radius

15mm radius
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Task 5 - Organize the specification tree.

1. Right-click on Geometrical Set.1 and select Geometrical Set.1 
object > Create Group. The Group dialog box opens as shown in 
Figure 1–68.

Figure 1–68

2. Select Wheel Extrude in the specification tree and every feature 
after it, as shown in Figure 1–69.

Figure 1–69
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3. Click  in the Group dialog box. The specification tree 
displays as shown in Figure 1–70. Note that only the selected 
features display in the group. This tool simplifies the specification 
tree. 

Figure 1–70

4. The wireframe and surfaces not in the group can be shown by 
right-clicking on Group-Geometrical Set.1 and selecting 
Geometrical Set.1 object > Expand Group. The specification 
tree displays as shown in Figure 1–71.

Figure 1–71

5. Right-click on Group-Geometrical Set.1 and select Geometrical 
Set.1 object > Collapse Group. The specification tree only 
displays the features placed in the group.

6. Save the model and close the file.



CATIA: Advanced Surface Design

1–46 © 2011, ASCENT - Center for Technical Knowledge®

Exercise 1c Using a Mask

In this exercise, you will open a part that contains imported surface 
data. You use the mask functionality to create two mask states of the 
model. The third and final mask that you create will be used to return 
the model to a state that displays all geometry in the part.

Goal After you complete this exercise, you will be able to:

Create masks for a part file

Task 1 - Open a part file.

1. Open 71499_Rotor.CATPart. The model displays as shown in 
Figure 1–72.

Figure 1–72

Task 2 - Create a mask.

1. Click  (Mask) in the Tools toolbar, as shown in Figure 1–73.

Figure 1–73
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A bounding box displays around the model. Each side of the box 
has a green handle, as shown in Figure 1–74.

Your bounding box could 
have a different orientation 
then the one shown. The 
bounding box is displayed 
relative to the orientation of 
the model.

Figure 1–74

Green handles on each side of the box
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2. Use the cursor to select the handle shown in Figure 1–75.

Figure 1–75

3. Drag the handle to the location shown in Figure 1–76.

Figure 1–76

4. Click . Note that Mask.1 has been added to the 
specification tree.

Select this handle
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Task 3 - Create a second mask.

1. Create another mask that results in the display shown in 
Figure 1–77.

Figure 1–77

2. Click  to complete the second mask.

Task 4 - Set a mask to be current.

1. Right-click on Mask.1 and select Mask.1 object > Set As 
Current. An active mask is indicated with a red icon, as shown in 
Figure 1–78.

Figure 1–78
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The model display updates as shown in Figure 1–79.

Figure 1–79

Task 5 - Set a mask to not be current.

1. Right-click on Mask.1 and select Mask.1 object > Set As Not 
Current. The model displays as shown in Figure 1–80.

Figure 1–80

2. Save the model and close the file.
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